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CONHECIMENTOS BÁSICOS

Atenção: As questões de números 1 a 10 baseiam-se no
texto apresentado abaixo.

Nem o cientista mais ortodoxo pode negar que mexer

com equações é difícil e cansativo. Mas a ciência não deixa de

ser bonita ou agradável apenas por causa disso. A arte, apesar

de bela, também não é fácil: todo profissional sabe a dor e a

delícia de aprender bem um instrumento ou de dominar o pincel

com graça e precisão. É verdade que dificilmente alguém

espera encontrar numa equação ou num axioma as qualidades

próprias da arte, como a harmonia, a sensibilidade e a ele-

gância.

A graça e a beleza das teorias, no entanto, sempre

tiveram admiradores – e hoje mais do que nunca, a julgar pela

quantidade de livros recentes cujo tema central é a sedução e o

encanto dos conceitos científicos. Exagero?

“As leis da física são em grande parte determinadas por

princípios estéticos”, afirma o astrônomo americano Mario Livio,

do Telescópio Espacial Hubble, também autor de um livro em

que analisa a noção de beleza dentro da ciência. Ele afirma

que, quando a estética surgiu na Antigüidade, os conceitos de

beleza e de verdade eram sinônimos. Para ele, o traço de união

entre arte e ciência reside exatamente nesse ponto. “As duas

representam tentativas de compreender o mundo e de organizar

fatos de acordo com uma certa ordem. Em última instância,

buscam uma idéia fundamental que possa servir de base para

sua explicação da realidade.”

Mas, se o critério estético é tão importante para o pen-

samento científico, como ele se manifesta no dia-a-dia dos

pesquisadores? O diretor do Instituto de Arte de Chicago acha

que sabe a resposta. “Ciência e arte se sobrepõem natural-

mente. Ambas são meios de investigação, envolvem idéias,

teorias e hipóteses que são testadas em locais onde a mente e

a mão andam juntas: o laboratório e o estúdio”, afirma.

Acredita-se que as descobertas científicas sirvam de

inspiração para os artistas, e as obras de arte ajudem a alargar

o horizonte cultural dos cientistas. Na prática, essa mistura gera

infinitas possibilidades. A celebração que artistas buscam hoje

já ocorreu diversas vezes no passado, de maneira mais ou

menos espetacular. Na Renascença, a descoberta da

perspectiva pelos geômetras encantou os pintores, que logo

abandonaram as cenas sem profundidade do período clássico e

passaram a explorar sensações tridimensionais em seus

quadros. Os arquitetos também procuravam dar às igrejas um

desenho geometricamente perfeito; acreditavam, com isso, que

criavam um portal para o mundo metafísico das idéias

religiosas.

No século XX, essa tendência voltou a crescer. A grande

preocupação dos pintores impressionistas com a luz, por

exemplo, tem muito a ver com as conquistas da ótica. A

matemática também teria influenciado a pintura do russo

Wassily Kandinsky, segundo o qual “tudo pode ser retratado por

uma fórmula matemática”. Seu colega Paul Klee achou um jeito

de colocar em vários quadros alguma referência às progressões

geométricas. Bem-humorado, brincava com as idéias da mate-

mática dizendo que “uma linha é um ponto que saiu para

passear”.

(Adaptado de Flávio Dieguez. Superinteressante, junho de
2003, p. 50 a 54)

1. É correto afirmar que no texto se encontra uma

(A) defesa da ciência como base para o desenvolvi-
mento da arte, que depende de alguns princípios
estabelecidos por aquela, para desenvolver-se
satisfatoriamente.

(B) análise de aspectos comuns à ciência e à arte, com
o intuito de apontar semelhanças e reciprocidades
entre uma e outra, cada qual com seus princípios e
objetivos.

(C) justificativa do predomínio da arte sobre os princípios
científicos, pois há evidências de ter ela surgido
muito antes, como manifestação do pensamento
humano.

(D) apreciação, de certo modo desfavorável, de algumas
teorias científicas que buscam explicar as fontes de
inspiração das obras de arte, no decorrer da História.

(E) avaliação, voltada para alguns princípios aceitos por
artistas, de que a ciência deve muito de seu
progresso às descobertas e soluções adotadas por
pintores em todas as épocas.

_________________________________________________________

2. Exagero? (final do 2o parágrafo)

A resposta correta à indagação acima encontra-se na
opinião de que

(A) os métodos utilizados, tanto por cientistas quanto
por artistas, são bastante semelhantes entre si.

(B) as teorias científicas se valorizam tanto mais quanto
mais se aproximam das teorias que envolvem as
manifestações artísticas.

(C) a arte se sobrepõe à ciência, com as inúmeras
possibilidades experimentais que surgem nos estúdios.

(D) os laboratórios científicos buscam sempre a verda-
de, enquanto as produções artísticas se voltam para
a beleza.

(E) a ambigüidade existente na definição dos conceitos
de arte e de ciência vem desde a Antigüidade.
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3. Para ele, o traço de união entre arte e ciência reside
exatamente nesse ponto. (3o parágrafo)

A expressão grifada indica, considerando-se o contexto,

(A) a busca por uma proposta que fundamentasse as
possíveis explicações para a realidade.

(B) os métodos que podem chegar aos mesmos
resultados, quer na arte, quer na ciência.

(C) a percepção de que a pesquisa científica é árida e
cansativa, assim como a preparação de uma obra de
arte.

(D) o idêntico sentido que sempre se atribuiu aos
conceitos, tanto de beleza quanto de verdade.

(E) as teorias científicas que tentaram explicar a har-
monia e a beleza das obras de arte.

_________________________________________________________

4. Considere as afirmativas que se fazem a respeito do
emprego de sinais de pontuação no texto:

I. O travessão que inicia o segmento – e hoje mais do
que nunca (2o parágrafo) − assinala uma pausa
maior no período, como ênfase para a afirmativa
introduzida por ele.

II. As aspas, que abrem e fecham o segmento “As
duas representam tentativas ... para sua explicação
da realidade.” (3o parágrafo), indicam reprodução
exata das palavras de um escritor.

III. Os dois-pontos em − ... andam juntas: o laboratório
e o estúdio ... (4o parágrafo) − introduzem um
segmento enumerativo.

Está correto o que se afirma em

(A) I, somente.

(B) III, somente.

(C) I e II, somente.

(D) II e III, somente.

(E) I, II e III.
_________________________________________________________

5. A substituição da expressão grifada por um pronome
correspondente está INCORRETA em:

(A) ou de dominar o pincel = de dominá-lo.

(B) analisa a noção de beleza = a analisa.

(C) buscam uma idéia fundamental = buscam-lhe.

(D) envolvem idéias, teorias e hipóteses = envolvem-nas.

(E) teria influenciado a pintura = tê-la-ia influenciado.

6. Na prática, essa mistura gera infinitas possibilidades.
(5o parágrafo)

O verbo que exige o mesmo tipo de complemento que o
do grifado acima está na frase:

(A) A arte, apesar de bela, também não é fácil ...

(B) ... quando a estética surgiu na Antigüidade ...

(C) ... o traço de união entre arte e ciência reside
exatamente nesse ponto.

(D) .. que logo abandonaram as cenas sem profundidade
do período clássico ...

(E) Bem-humorado, brincava com as idéias da
matemática ...

_________________________________________________________

7. ... acreditavam, com isso, que criavam um portal para o
mundo metafísico das idéias religiosas. (5o parágrafo)

Os verbos grifados acima, considerando-se o tempo e o
modo em que se encontram, indicam, no contexto,

(A) processo em decurso permanente no passado.

(B) ação realizada em um tempo determinado, no
passado.

(C) probabilidade de realização de um fato qualquer.

(D) situação transcorrida no passado, anterior a outra,
também passada.

(E) condição essencial para a realização de um fato.
_________________________________________________________

8. ... que as descobertas científicas sirvam de inspiração
para os artistas ... (5o parágrafo)

O verbo que se encontra nos mesmos tempo e modo do
grifado acima está na frase:

(A) Mas a ciência não deixa de ser bonita ou agradável
apenas por causa disso.

(B) Em última instância, buscam uma idéia funda-
mental ...

(C) ... que possa servir de base para sua explicação da
realidade.

(D) ... como ele se manifesta no dia-a-dia dos
pesquisadores?

(E) ... que logo abandonaram as cenas sem
profundidade do período clássico ...

MODELO − Caderno de Prova, Cargo Y23, Tipo 001



4 TREPB-Conhecimentos-Básicos4

9. A concordância verbo-nominal está inteiramente correta
na frase:

(A) Segundo alguns cientistas, as mais brilhantes
fórmulas da física ou da biologia é comparável ao
que de melhor foi feito na literatura do século XX.

(B) O princípio da economia aproxima a poesia, com
seu inigualável poder de síntese, das equações
matemáticas, que resumem grande quantidade de
informações.

(C) Nem sempre as informações que se encontra
disponível para um cientista pode orientá-lo na
busca de soluções para o problema que tentam
resolver.

(D) Cientistas, em toda a História, defende a idéia de
que tanto a estética científica quanto a artística se
caracteriza pela busca da ordem em seu mais alto
grau.

(E) A emoção é um dos ingredientes mais importantes
da estética científica, embora se pensem que deve
estar distantes dos objetivos dos pesquisadores.

_________________________________________________________

10. Os cientistas esforçam-se por mostrar que existe arte por
trás das equações.
Artistas contemporâneos procuram aproximar-se da
ciência.
Observa-se um esforço recíproco na tentativa de recuperar
uma antiga fórmula da filosofia grega.
Na filosofia grega, beleza é igual a verdade.

As frases acima articulam-se em um único período, com
clareza, correção e lógica, da seguinte maneira:

(A) Os cientistas esforçam-se por mostrar que existe
arte por trás das equações, do modo como artistas
contemporâneos procuram aproximar-se da ciência,
observando-se um esforço recíproco na tentativa de
recuperar uma antiga fórmula da filosofia grega: de
cuja a beleza é igual a verdade.

(B) Na filosofia grega beleza é igual a verdade, pois os
cientistas esforçam-se por mostrar que existe arte
por trás das equações; de que os artistas
contemporâneos procuram aproximar-se da ciência,
é observado um esforço recíproco na tentativa de
recuperar-se essa antiga fórmula da filosofia grega.

(C) Artistas contemporâneos procuram aproximar-se da
ciência, desde quando os cientistas esforçam-se por
mostrar que existe arte por trás das equações;
observa-se um esforço recíproco que tenta recuperar
uma antiga fórmula da filosofia grega, a fórmula da
beleza verdadeira.

(D) Os cientistas esforçam-se por mostrar que existe
arte por trás das equações; artistas contemporâneos
procuram aproximar-se da ciência, onde observa-se
um esforço recíproco, o qual tenta recuperar uma
antiga fórmula da filosofia grega: beleza é igual a
verdade.

(E) Observa-se um esforço recíproco na tentativa de
recuperar uma antiga fórmula da filosofia grega, segundo
a qual beleza é igual a verdade: os cientistas
esforçam-se por mostrar que existe arte por trás das
equações, enquanto artistas contemporâneos procuram
aproximar-se da ciência.

11. Com relação aos sistemas operacionais, considere:

I. Conjunto de programas que gerenciam os recursos
do computador.

II. Conjunto de editores de textos e de planihas
eletrônicas para automação comercial.

III. Conjunto de programas que faz a interface entre o
usuário e o computador.

É correto o que se afirma APENAS em:

(A) I.
(B) I e II.
(C) I e III.
(D) II.
(E) III.

_________________________________________________________

12. Na Internet, um conjunto de páginas e de arquivos de um

servidor é chamada de IKK , que é acessado através de

um software conhecido como  IIKK  e a primeira página a

ser  acessada,  normalmente  recebe  o  nome  de  IIIKK

Preenchem correta e respectivamente as lacunas I, II

e III:

(A) Web, Link e site
(B) link, Web e página HTML
(C) site, navegador e home page
(D) home page, browser e site
(E) página HTML, navegador e home page.

_________________________________________________________

13. Quanto aos direitos e garantias fundamentais previstos na
Constituição Federal, é INCORRETO afirmar que

(A) ninguém poderá ser compelido a associar-se ou a
permanecer associado.

(B) ninguém será obrigado a fazer ou deixar de fazer
alguma coisa senão em virtude de lei.

(C) a propriedade atenderá a sua função social.

(D) a lei não retroagirá, salvo para prejudicar o réu.

(E) é assegurado a todos o acesso à informação e
resguardado o sigilo da fonte, quando necessário ao
exercício profissional.

_________________________________________________________

14. Em tema de Direitos Políticos é CORRETO afirmar que

(A) não podem alistar-se como eleitores os estrangeiros
e, durante o período do serviço militar, os conscritos.

(B) são elegíveis os inalistáveis e os analfabetos.

(C) a idade mínima para concorrer ao cargo de Prefeito
é de dezoito anos.

(D) o alistamento e o voto são obrigatórios para maiores
de dezesseis e menores de dezoito anos.

(E) para concorrer a outros cargos o Presidente da
República deve renunciar ao respectivo mandato até
trinta dias antes do pleito.
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15. Considere:

I. A composição dos Tribunais Eleitorais é híbrida,
integrando juizes de outros tribunais federais e
estaduais, juristas da classe dos advogados e
membros do Ministério Público.

II. Os juízes dos tribunais eleitorais, salvo motivo
justificado, servirão por dois anos no mínimo, e
nunca por mais de dois biênios consecutivos, sendo
os substitutos escolhidos na mesma ocasião e pelo
mesmo processo e em número igual para cada
categoria.

III. As Juntas Eleitorais serão compostas por 2 ou 4
membros, os quais, por eleição e pelo voto secreto,
escolherão seu presidente.

A respeito da composição dos órgãos da Justiça Eleitoral,
é correto o que se afirma APENAS em

(A) II.

(B) III.

(C) I e II.

(D) II e III.

(E) I e III.
_________________________________________________________

16. Quatro candidatos disputaram a eleição de Governador do
Estado. O mais votado, antes de realizado o segundo
turno, renunciou à sua candidatura. Nesse caso,

(A) o segundo turno será disputado entre o segundo
colocado e o candidato a Vice-Governador do que
renunciou.

(B) o segundo turno será disputado entre o segundo
colocado e, dentre os remanescentes, o mais idoso.

(C) não será realizado segundo turno e a renúncia do
mais votado implicará na convocação de novas
eleições.

(D) o partido político a que pertencia o renunciante
deverá indicar substituto para disputar o segundo
turno com o segundo colocado.

(E) o segundo turno será disputado entre o segundo
colocado e, dentre os remanescentes, o de maior
votação.

_________________________________________________________

17. O conceito de que a Administração Pública deve agir de
modo rápido e preciso com o fim de produzir resultados
que satisfaçam as necessidades da população, diz
respeito ao princípio da

(A) impessoalidade.

(B) eficiência.

(C) legalidade.

(D) continuidade.

(E) moralidade.

18. A Administração Pública que desejar comprar ou alienar
bens imóveis, em regra, poderá contratar por meio de
licitação na modalidade

(A) concorrência.

(B) pregão.

(C) tomada de preços.

(D) concurso.

(E) convite.
_________________________________________________________

19. Adônis foi nomeado técnico judiciário no Tribunal Regional
Eleitoral de certo Estado membro. Nesse caso, dentre os
requisitos básicos para a investidura de Adônis nesse
cargo é a aptidão física e mental, que deverá ser
demonstrada mediante

(A) um atestado médico, de cada aptidão, oficiais ou
não, antes de sua posse.

(B) inspeção médica oficial depois da posse, mas antes
de sua entrada em exercício.

(C) inspeção médica oficial realizada antes de sua
posse.

(D) dois atestados médicos oficiais, apresentados
durante seu estágio probatório.

(E) inspeção médica, oficial ou não, no início de seu
estágio probatório.

_________________________________________________________

20. Analise:

I. O Executivo, Legislativo e Judiciário da União são
considerados autoridades.

II. A unidade de atuação dotada de personalidade
jurídica é considerada entidade.

III. Considera-se órgão a unidade de atuação inte-
grante da estrutura da Administração direta e da
estrutura da Administração indireta.

Para os fins da Lei no 9.784/99, que regulamenta o
processo administrativo no âmbito da Administração Públi-
ca Federal, está correta APENAS as afirmações de

(A) I.

(B) I e II.

(C) I e III.

(D) II.

(E) II e III.
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CONHECIMENTOS ESPECÍFICOS

21. Considere a a janela representada abaixo.

Ela é do tipo

(A) guilhotina.

(B) projetante.

(C) pivotante horizontal.

(D) pivotante vertical.

(E) correr.

_________________________________________________________

22. Um lote de terreno retangular medido em planta com
régua comum (simples), apresentou as medidas da figura.

4 cm

6 
cm

Sabendo-se que o desenho está na escala de 1:500, a área
do lote, em m2, é de

(A)   240

(B)   480

(C)   600

(D)   960

(E) 1200

Atenção: Para responder às questões de números 23 e 24,
considere a planta do pavimento abaixo.

3

5

2 1

1

2

suíte

banheiro

suíte

terraçoterraço

4

4

23. Os elementos 1  e 2  são, respectivamente,

(A) ventilações e torneiras.

(B) shafts e chuveiros.

(C) caixas de inspeção e registros.

(D) armários embutidos e chuveiros.

(E) gaveteiros para roupa suja e torneiras.
_________________________________________________________

24. Os elementos 3 , 4  e 5  representam, respectivamente,

(A) sofá, criado-mudo e cama.

(B) cama, cadeira e sofá.

(C) penteadeira, banco e cama.

(D) armário embutido, criado-mudo e cama.

(E) cama simples, banco e cama dupla.
_________________________________________________________

25. Observe os símbolos abaixo.

      e      

Eles representam, respectivamente,

(A) luva e união.

(B) torneira de bóia e ralo.

(C) hidrômetro e junção com derivante para cima.

(D) união e cruzeta.

(E) tubo reto horizontal e tubo de queda.
_________________________________________________________

26. Para receber a água dos vasos sanitários é recomendável
o uso de

(A) ralos simples.

(B) ralos sifonados.

(C) caixas de passagem.

(D) desconectores ou sifões (caixas sifonadas).

(E) caixa de inspeção.
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27. Observe os símbolos abaixo.

 ,                  e         

Eles representam, respectivamente,

(A) interruptor paralelo, interruptor simples e ponto de
luz.

(B) quadro de distribuição, ponto de luz na parede e
disjuntor.

(C) tomada 127V 2P+T média, tomada 127V 2P+T alta e
ponto 220V bifásico alto.

(D) interruptor simples, quadro de distribuição e
condutor.

(E) tomada 127V 2P+T baixa, tomada 127V 2P+T média
e ponto 220V bifásico médio.

_________________________________________________________

28. Observe a figura abaixo.

50 40 30 20 10

Superfície terreno

Ela representa:

(A) elevação.

(B) depressão.

(C) espigão.

(D) garganta.

(E) vertente.
_________________________________________________________

29. Considere a convenção topográfica abaixo.

Ela representa:

(A) via acompanhada de linha telefônica.

(B) via acompanhada de linha telegráfica.

(C) estrada de ferro.

(D) estrada de rodagem dupla.

(E) túnel de estrada de ferro.

30. Ao iniciar-se a construção de um edifício escolar em uma
cidade do interior em terreno retangular de 50 × 40 m, em
loteamento novo com apenas a demarcação dos lotes, é
necessário demarcar o lote para a instalação do canteiro.
A trena fornece os lados, enquanto os ângulos são
determinados por triangulação.

50,00

40
,0

0

As diagonais 1 e 2 devem medir, em metros, respectivamente
e aproximadamente,

(A) 64 e 62
(B) 64 e 64
(C) 50 e 55
(D) 50 e 50
(E) 45 e 45

_________________________________________________________

Atenção: Para responder às questões de números 31 e 32
considere a figura que representa uma fôrma de
concreto.

V1

V3

V
6

V5

V
7

V
10

L1 L2 L3

L4

L5 L6 L7

V
8

V
9

h=8 h=8 h=8

h=8 h=8 h=8 escada

V4

h=7

V2

31. Com relação às vigas,

(A) V1 é semi-invertida e V3 é normal (direta).
(B) V3 é invertida e V5 é normal (direta).
(C) V6 e V8 são semi-invertidas.
(D) V6 e V8 são normais (diretas).
(E) Todas são normais (diretas).

_________________________________________________________

32. Com relação às lajes,

(A) todas são rebaixadas.
(B) todas são pré-moldadas.
(C) L3 é rebaixada.
(D) L1 é rebaixada.
(E) somente L4 é maciça.

_________________________________________________________

33. Numa mistura de concreto feito na obra, o traço é
1:2,5:3,5 em volume e o consumo de cimento é de
300 Kg/m3. A quantidade aproximada em litros de areia e
de pedra, respectivamente, para um saco de cimento é:

(A) 175  e  125
(B) 126  e    90
(C) 125  e  175
(D) 100  e  150
(E)   90  e  126

Dados:
1 saco de cimento = 36 litros
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Atenção: Considere a figura abaixo para responder às
questões de números 34 e 35.

A

B

C

D

1 2

3 4

terreno

alinhamento

construção

Rua

34. O afastamento ou recuo lateral mínimo para abertura de
portas e janelas, deve ser, em metros, de

(A) 1,00
(B) 1,50
(C) 1,80
(D) 2,00
(E) 2,50

_________________________________________________________

35. O recuo de frente em relação ao meio fio da rua deve ser
medido a partir

(A) de C até o prolongamento de 3-4.

(B) do ponto 3 e perpendicular ao alinhamento.

(C) do ponto médio entre 3-4 e perpendicular a reta 3-4.

(D) do ponto 4 e perpendicular ao alinhamento.

(E) do ponto médio de C-D até o ponto médio de 3-4.
_________________________________________________________

36. Os códigos de obra dos Municípios classificam os compar-
timentos de uma edificação conforme sua destinação. Os
destinados à atividades escolares são considerados de
permanência

(A) prolongada.

(B) especial.

(C) transitória.

(D) fixa.

(E) mista.

_________________________________________________________

37. Em caso de reformas e adaptações as rampas de
circulação de uso comum ou coletivo devem ter largura
mínima, em metros, e declividade máxima, em %, res-
pectivamente, de

(A) 1,00  e  11

(B) 1,20  e  15

(C) 1,30  e  10

(D) 1,20  e  12,5

(E) 1,70  e  15

38. A característica do meio físico ambiental que mais
influencia em uma construção é

(A) água.

(B) solo.

(C) ar.

(D) sol.

(E) clima.

_________________________________________________________

39. Salas de aula devem ter insolação

(A) nos dias frios.

(B) de manhã.

(C) de tarde.

(D) nos dias quentes.

(E) em todo o período.

_________________________________________________________

40. Num ambiente litorâneo é desejável que o sol bata nos
cômodos de permanência noturna no período

(A) da tarde.

(B) todo.

(C) da manhã.

(D) de inverno.

(E) de verão.

_________________________________________________________

41. Com relação às escavações para a realização de obras de
fundações em uma construção é INCORRETO:

(A) dispor de escadas ou rampas quando sua profun-
didade for superior a 1,25 m.

(B) escavações até 2,00 m de profundidade podem, em
geral, ser executadas sem especial segurança com
paredes verticais.

(C) depositar os materiais retirados a uma distância
superior à metade da profundidade, a partir da borda
do talude.

(D) todas as escavações que devem ser pisadas por
pessoas, precisam dispor de um espaço de trabalho
≥ 0,50 m de largura.

(E) prever, para trabalhos em valas para condutos e
canais, onde há tráfego de pessoas, largura livre de
0,60 m para diâmetros ≤ 0,40 m.
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42. O detalhe adequado para a amarração de duas paredes
de blocos cerâmicos ou de concreto, que evita a trinca
vertical, é:

(A)

chapisco

(B)

argamassa
 de cimento e areia

(C)

uma barra
de aço a cada 2 fiadas

(D)

duas barras
de aço a cada 2 fiadas

(E)

uma barra
de aço a cada 2 fiadas

43. Após a execução das paredes internas, o azulejo deve ser
aplicado sobre as mesmas no prazo de

(A) 1dia.

(B) 2 dias.

(C) ≤ 4 dias.

(D) 6 dias.

(E) ≥ 8 dias.
_________________________________________________________

44. A espessura da camada de argamassa de assentamento
de azulejos sobre paredes internas deve ser, em cm, de

(A) ≤ 2

(B) > 3

(C) = 4

(D) ≤ 5

(E) = 6
_________________________________________________________

45. Para receber tinta fresca sobre massa corrida, as paredes
e peças de concreto devem ser preparadas seqüen-
cialmente com:

(A) massa grossa, chapisco e massa fina.

(B) selante, massa grossa e massa fina.

(C) chapisco, massa grossa e massa fina.

(D) massa grossa, selante e massa fina.

(E) selante, chapisco e massa fina.
_________________________________________________________

46. Com relação aos tipos e sistemas de impermeabilização, é
INCORRETO afirmar:

(A) Emulsões de polímeros originalmente rígidos
(acrílicos, acetato de polivinil etc) não são recomen-
dados para áreas externas de climas equatoriais ou
semi-equatoriais.

(B) Sistemas rígidos são recomendados para grandes
áreas sujeitas a grandes sobrecargas.

(C) O número mínimo de camadas de feltro asfáltico
coladas entre si com asfalto é de três.

(D) O sistema de multimembranas asfálticas é reco-
mendado para estruturas contra água de subpressão
e de percolação.

(E) Toda impermeabilização deve ter sua superfície pro-
tegida contra esforços mecânicos.
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47. A figura abaixo mostra uma laje de cobertura corretamente
impermeabilizada e isolada termicamente.

1 2 3 4

Os elementos 1 , 2 , 3  e 4  representam,
respectivamente,

1 2 3 4

(A) isolamento
térmico

camada
impermeabi-

lizante

proteção
mecânica

pedra brita
ou

pedregulho

(B) concreto
magro

pintura
impermeabi-

lizante

camada
impermeabili-

zante

proteção
mecânica

(C)
1a argamassa

de
regularização

camada
impermeabi-

lizante

2a camada de
regularização

pedra brita

(D) isolamento
térmico

cortina de
vácuo

proteção
mecânica

pedregulho

(E) camada
amortecedora

pasta de
cimento

concreto de
regularização

pedregulho
_________________________________________________________

48. A figura abaixo representa um painel de alvenaria de bloco
de concreto de 14 × 39 × 19 cm.

janela

520 60

160200160

60

30
0

4
0

20
0

60
40

40

39
14

19

Desenhos sem escala

O número de blocos consumidos e a área, em m2, para
efeito de pagamento de mão-de-obra é, respectivamente,

(A) 195  e  15,6

(B) 170  e  14,6

(C) 120  e  11,6

(D) 145  e  13,6

(E) 100  e  10,6

49. Em um canteiro de obra onde estão previstos 30
trabalhadores, devem estar previstos, pelo menos:

Sanitários Chuveiros

(A) 4 5

(B) 3 4

(C) 2 3

(D) 1 2

(E) 1 1

_________________________________________________________

50. Quanto aos mictórios instalados em canteiro de obra é
INCORRETO afirmar que eles devem

(A) ser individuais ou coletivos.

(B) ter revestimento interno de material liso, impermeá-
vel e lavável.

(C) ser providos de descarga.

(D) ficar a uma altura máxima de 0,50 m do piso.

(E) ser ligados, obrigatoriamente, à rede pública.
_________________________________________________________

51. Com o comando line acionado e o units no modo default
do Autocad 2004, o comando @25<60 desenhará uma
linha de vinte e cinco

(A) metros de comprimento na inclinação de sessenta
graus.

(B) metros de comprimento numa inclinação menor que
sessenta graus.

(C) centímetros de comprimento na inclinação de
sessenta graus.

(D) centímetros de comprimento numa inclinação menor
que sessenta graus.

(E) graus com sessenta metros de comprimento.
_________________________________________________________

52. Para criar um novo estilo de dimensões no Autocad 2004,
o caminho correto é

(A) Dimension>New>Dimension Style.

(B) Dimension>Format>Dimension Style>New.

(C) Format>Dimension Style>New.

(D) Draw>Dimension Style>New.

(E) Draw>New>Dimension Style.

Obs.:
− considerar a espessura da arga-

massa de assentamento igual a
1 cm;

− considerar critérios normalmente
usados para efeito de medição.
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53. A função dos comandos Stretch, Fillet, e Offset no
Autocad 2004 é, respectivamente:

(A) Alongar um objeto, linha ou poli-linha; Unir duas
linhas (ou poli-linhas) perpendiculares informando o
raio do ângulo a ser adotado; Copiar apenas linhas
paralelamente informando a distância entre a original
e a cópia.

(B) Alongar um objeto, linha ou poli-linha; Unir duas
linhas (ou poli-linhas) perpendiculares informando o
raio do ângulo a ser adotado; Copiar linhas ou poli-
linhas paralelamente informando a distância entre a
original e a cópia.

(C) Alongar um objeto, linha ou poli-linha; Unir duas li-
nhas (ou poli-linhas) perpendiculares através de uma
terceira linha com comprimento a ser determinado;
Copiar linhas ou poli-linhas paralelamente infor-
mando a distância entre a original e a cópia.

(D) Estender uma linha ou poli-linha até outro objeto,
linha ou poli-linha; Unir duas linhas perpendiculares
informando o raio do ângulo a ser adotado; Copiar
linhas ou poli-linhas paralelamente informando a
distância entre a original e a cópia.

(E) Estender uma linha ou poli-linha até outro objeto,
linha ou poli-linha; Unir duas linhas ou poli-linhas
perpendiculares através de uma terceira linha com
comprimento a ser determinado; Copiar apenas
linhas paralelamente informando a distância entre a
original e a cópia.

_________________________________________________________

54. Em relação ao Autocad 2004, considere:

I. O Autocad é um software baseado em coordenadas
x, y, z e w, sendo que estas coordenadas
determinam se os desenhos serão em 2D e/ou 3D.

II. Os chamados comandos de atalho não podem ser
modificados, pois o autocad não oferece opções
para esta função.

III. Na opção Options do menu Tools, o autocad
oferece ao usuário a opção para que o arquivo
quando salvo seja em versões anteriores a utilizada
ou em .dwf.

É correto o que se afirma em:

(A) I, apenas.

(B) I e II, apenas.

(C) I, II e III.

(D) II e III, apenas.

(E) III, apenas.
_________________________________________________________

55. Um quadrado no Autocad 2004 é desenhado através de

(A) linha simples ou poli-linha, apenas.

(B) linha simples, poli-linha ou através do menu Insert.

(C) linha simples, poli-linha ou através do comando
Retangle.

(D) linha simples, poli-linha ou através do menu Draw.

(E) poli-linha, apenas.

56. No que concerne às licitações, é INCORRETO afirmar:

(A) Segundo o princípio da adjudicação compulsória, a
Administração Pública é obrigada a contratar
imediatamente com o licitante vencedor.

(B) O julgamento das propostas deve ser objetivo e
pautado por critérios claros contidos no edital.

(C) Quanto à competição no processo licitatório, pode-
se afirmar que é relativa, na medida em que, no
interesse público, impõe-se regras, dentre outras,
que afastam licitante não constituído regularmente.

(D) No convite pode-se dizer que a publicidade é
mitigada, pois não se exige maior divulgação, sendo
reservada a competição aos licitantes convidados.

(E) São modalidades de licitação a concorrência, a
tomada de preços, o convite, o concurso, o leilão e o
pregão.

_________________________________________________________

57. No caso em que todos os licitantes forem inabilitados ou
todas as propostas forem desclassificadas, a administra-
ção poderá fixar aos licitantes o prazo de

(A) dez dias úteis para a apresentação de nova docu-
mentação ou de outras propostas, facultada, no caso
de convite, a redução deste prazo para cinco dias
úteis.

(B) cinco dias úteis para a apresentação de nova docu-
mentação ou de outras propostas, facultada, no caso
de convite, a redução deste prazo para três dias
úteis.

(C) três dias úteis para a apresentação de nova docu-
mentação ou de outras propostas, em todas as
modalidades de licitação.

(D) oito dias úteis para a apresentação de nova do-
cumentação ou de outras propostas, facultada, no
caso de convite, a redução deste prazo para três
dias úteis.

(E) quinze dias úteis para a apresentação de nova
documentação ou de outras propostas, facultada, no
caso de convite, a redução deste prazo para cinco
dias úteis.

_________________________________________________________

58. A respeito da habilitação no processo licitatório, a
inscrição do ato constitutivo, no caso de sociedades civis,
acompanhada de prova da diretoria que se encontra em
exercício, é documentação relativa à

(A) qualificação técnica.

(B) habilitação jurídica.

(C) qualificação econômica.

(D) regularidade fiscal.

(E) habilitação de responsabilidade financeira.
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59. Nos termos da Lei no 8.666/93, é correto o que consta
APENAS em:

(A) O contratado fica obrigado a aceitar, nas mesmas
condições contratuais, os acréscimos ou supressões
que se fizerem nas compras, até cinqüenta por
cento do valor inicial atualizado do contrato.

(B) Quando ocorrer caso fortuito impeditivo da execução
do contrato, haverá rescisão contratual e, inde-
pendentemente da culpa do contratado, será ele
ressarcido dos prejuízos demonstrados.

(C) Em regra, o prazo é de cento e vinte dias para
observação ou vistoria comprovadora da adequação
do objeto aos termos do contrato administrativo.

(D) Se houver agente público nomeado para fiscalizar o
cumprimento do contrato, é facultado ao contratado
manter preposto no local da obra ou serviço, para
representá-lo na execução do contrato.

(E) A Administração Pública responde solidariamente
com o contratado pelos encargos previdenciários
resultantes da execução do contrato, nos termos da
legislação específica.

_________________________________________________________

60. Tendo em vista as disposições da Lei no 8.666/93,
considere:

I. Os contratos administrativos regulam-se pelas suas
cláusulas e pelos preceitos de direito público,
aplicando-se-lhes, supletivamente, os princípios da
teoria geral dos contratos e as disposições de
direito privado.

II. A garantia do contrato administrativo, cujas
modalidades são, dentre outras, caução em
dinheiro e fiança bancária, sempre será exigida
pela Administração no patamar de dez por cento do
valor contratado.

III. As cláusulas econômico-financeiras e monetárias
dos contratos administrativos poderão ser alteradas
sem prévia concordância do contratado.

IV. Não se admite contrato com prazo de vigência
indeterminado, sendo admissível a prorrogação,
desde que justificada por escrito e previamente
autorizada pela autoridade competente.

É correto o que consta APENAS em:

(A) I e III.

(B) II e III.

(C) I e IV.

(D) I, II e IV.

(E) II, III e IV.
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